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This detailed walkthrough for Java and C/C++ developers explains how to install Eclipse IDE on Microsoft 

Windows. Installation of Cygwin required for C/C++ development is also described. Using Eclipse to 

create simple test programs is illustrated. 
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)ÎÔÒÏÄÕÃÔÉÏÎ 
As you are aware, websites and software are frequently updated.  When you follow these instructions, you may see 

some differences between the actual installation process and the process described in the instructions. 

Unless otherwise stated, Windows, Java, Eclipse, and Cygwin components are assumed to be 64-bit. Look in Appendix 15 

ς Using 32-bit Software if you are interested in 32-bit versions. 

Eclipse requires Java Platform, Standard Edition (Java SE) to run. The main text of this document describes how to install 

Java SE 11, specifically Oracle OpenJDK 11. If you need to install a different Java version or variant, look in Appendix 8 ς 

Installing Oracle JDK for Java SE 11 (Long Term Support) and Appendix 9 ς Installing Legacy Versions of Java SE. 

Eclipse, Java, and Cygwin components 

To use Eclipse for Java and/or C/C++ development, you shall install all or some of the following software components 

¶ Java Development Kit (JDK) for Java Platform, Standard Edition 11 (Java SE 11), one of the following 

o Oracle OpenJDK ς free, open source license  

o Oracle JDK ς if commercial license is required 

¶ Eclipse, one of the following 

o Eclipse IDE for Java Developers  

o Eclipse IDE for Java EE Developers (includes IDE for Java Developers) 

o Eclipse IDE for C/C++ Developers (includes CDT below) 

¶ Eclipse C/C++ Development Tooling (CDT) if both Java and C/C++ programs are to be developed. 

¶ Cygwin (Devel package) if C/C++ programs are to be developed. 
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Enabling Programming Languages  

Enabling all programm ing languages 

To enable everything - Java, Java (Jakarta) Enterprise, and C/C++ development - install the following combination 

¶ Java SE Development Kit (JDK) 

¶ Eclipse IDE for Java EE Developers (includes IDE for Java Developers) 

¶ Eclipse C/C++ Development Tooling (CDT) 

¶ Cygwin (Devel package)  

Total disk space that is required to install all mentioned above software is approximately 11 GiB. 

Enabling Java SE programming language only  

To enable only Java SE - install the following combination 

¶ Java SE Development Kit (JDK) 

¶ Eclipse IDE for Java Developers 

Total disk space that is required to install all mentioned above software is approximately 0.5 GiB. 

Enabling C/C++ programming languages only  

To enable C/C++ development only - install the following combination 

¶ Java SE Development Kit (JDK) 

¶ Eclipse IDE for C/C++ Developers (includes CDT below) 

¶ Cygwin (Devel package) 

Total disk space that is required to install all mentioned above software is approximately 11 GiB. 



Installing Eclipse IDE on Windows for Java and C/C++ Developers  

© Copyright 2019 Alexander Murashkin            

Page 8 of 292 

Revision 20190205 

Specific programming languages  requirements  

You may save your time and disk space if you install only necessary software components. 

Here is a table that describes minimum software requirements depending on programming languages that are used for 

development. Select the column corresponding to the languages and install all components marked with Yes. 

 Disk 

Space 

(GiB) 

Setup 

Space 

(GiB) 

C and 

C++ 

Java Java and 

Java 

Enterprise2 

C, C++, 

and Java 

C, C++, Java, 

and Java 

Enterprise2 

Java Development Kit (JDK) 0.3 0.2 Yes Yes Yes Yes Yes 

Eclipse IDE for Java Developers 0.2  0.2  Yes  Yes  

Eclipse IDE for Java EE Developers  
* includes IDE for Java Developers 

0.4 0.4   Yes  Yes 

C/C++ Development Toolkit (CDT)1 0.06 -    Yes1 Yes1 

Eclipse IDE for C/C++ Developers  
* includes C/C++ Development Toolkit 

0.3 0.2 Yes     

Cygwin (Devel package) 10 2 Yes   Yes Yes 

Installation Disk Space (GiB)   10.7  0.5 0.7 10.6  10.8  

Temporary Setup Space (GiB)     2.4 0.4 0.6   2.4  2.7 

 

The temporary setup space mentioned above includes disk space needed to store setup files (the downloaded ZIP 

archives, packages, and setup programs). Unless you remove the setup files after each step, you will need disk space 

equal to the sum of the installation and temporary space. 

Note 1 - C/C++ Development Tooling (CDT) is an add-on to Eclipse. If a mixed C/C++ and Java development is required, 

install Eclipse IDE for Java (or Java EE) first and CDT add-on second. 

Note 2 - To run Java Enterprise programs an appropriate Java Enterprise Application Server is required (that is out of this 

document scope). 
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*ÁÖÁ 3ÔÁÎÄÁÒÄ %ÄÉÔÉÏÎ ɉ*ÁÖÁ 3%Ɋ 

Introduction  

Java Platform, Standard Edition (Java SE)Ɂ is a software platform that lets you develop and deploy Java applications. 

Eclipse IDE is written mostly in Java, for this reason, it requires Java SE to run. 

If you are developing Java programs, you will also need Java SE to be installed. In many cases, the same Java SE 

installation can be used to run Eclipse IDE itself and to develop and run Java programs via Eclipse IDE.  It is also possible 

to install multiple versions and variants of Java SE and to use some of them to run Eclipse and some of them for 

development. 

https://www.oracle.com/technetwork/java/javase/overview/index.html
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Requirements 

It is recommended to install Java SE 11 64-bit Development Kit (JDK). Free (open source) JDK variant is called Oracle 

OpenJDK, its installation is described below. If you prefer a commercial variant, see Appendix 8 ς Installing Oracle JDK 

for Java SE 11 (Long Term Support).  

You will need approximately the following free disk space before installing Java SE 11 

 Java SE 11 64-bit Folder 

Size after Installation 

Size of Downloaded ZIP or 

Setup File 

Temporary 

Total Size 

Oracle OpenJDK (free) 286 MiB  179 MiB 465 MiB 

Oracle JDK (commercial) 278 MiB 151 MiB 429 MiB 

 

Abovementioned temporary disk space is required to store downloaded OpenJDK ZIP archive file or JDK setup program 

file. You can remove these files after completing the installation. 

Using Legacy Versions of Java  

You may install Java SE 10 or Java SE 8 instead of Java SE 11 if so needed. When running legacy Java SE setup program, 

the setup screens are very similar to the example screenshots below, the main difference is the Java banner color. 

See Java Standard Edition 10 (64-bit) and Java Standard Edition 8 (32-bit and 64-bit) in Appendix 9 ς Installing Legacy 

Versions of Java SE for more details. 

Note - Java SE 8 does not have public updates after January 2019. Java SE 9 has reached end of support. Users of Java SE 

8 and 9 should switch to Java SE 11 or 10.  
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Downloadi ng Oracle OpenJDK  

To download Oracle OpenJDK for Java Standard Edition 11, in your browser, go to JDK 11 General-Availability ReleaseɁ 

webpage.  

 

In the Builds section find Windows/x64 line and click on zipɁ link. 

Depending on your browser, you will get a download prompt.  Download and save the ZIP file. See Appendix 11 ς 

Downloading and Running files from the Internet if you need help with it. 

Open the folder containing the saved file. For example 

   

http://jdk.java.net/11
https://download.java.net/java/ga/jdk11/openjdk-11_windows-x64_bin.zip
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OpenJDK Parent Installation Folder  

Decide where you want OpenJDK to be installed to (the installation folder). You have two choices 

1. If you are going to use OpenJDK and nobody else ς install it in your data directory, for example, under 

C: \ Users \ Richard \ OpenJDK. You will not need an administrator access to install OpenJDK in this case. 

2. If other users are going to use Eclipse ς install it in the program directory, for example, under C: \ Program 

Files \ OpenJDK. You will need an administrator access to install OpenJDK in this case. 

The table below describes the parent folder selection. Substitute your actual username for username.  

 If you are going to use OpenJDK and nobody else If other users are going to use it 

Windows 64-bit & 

OpenJDK 64-bit 

C: \ Users \ username \ OpenJDK C: \ Program Files \ OpenJDK 

 

Note - It is not recommended to install OpenJDK under C: \ Program Files \ Java  folder as this folder is used by 

Oracle JDK (commercially supported version). 

Extracting OpenJDK Files 

Create the OpenJDK parent installation folder and extract files from the downloaded ZIP archive there. If you need help 

with the ZIP files extraction, see an example in Appendix 12 ς Extracting Eclipse Files to the Destination Folder. 

Open the OpenJDK parent installation folder.  

 

When the ZIP archive is extracted, it creates subfolder matching the OpenJDK version (jdk - 11  in the screenshot). Click 

on the subfolder to view it content. 



Installing Eclipse IDE on Windows for Java and C/C++ Developers  

© Copyright 2019 Alexander Murashkin            

Page 13 of 292 

Revision 20190205 

 

In this example, the complete path to OpenJDK 11 is C: \ Program Files \ OpenJDK\ jdk - 11 . 

Note ς The created subfolder name contains JDK version, so you can install multiple versions of OpenJDK in the same 

parent installation folder. For instance, if you install OpenJDK 12, the subfolder will be jdk - 12 . 

Enabling Eclipse Launching via OpenJDK 

To be able to run Eclipse, Eclipse launcher has to know OpenJDK installation folder path. One way is to make OpenJDK 

default ς to add OpenJDK bin subfolder to Windows PATH environment variable as described below. 

If you do not want to use OpenJDK as default Java virtual machine, you can use one of the following approaches  

¶ After Eclipse is installed, add appropriate - vm option to eclipse.ini  file (see Appendix 11 ς Downloading 

and Running files from the Internet). 

¶ Add appropriate - vm option to an Eclipse shortcut (see section Using Shortcut Command Line to Specify Java 

Virtual Machine in Appendix 6 ς Making Eclipse Shortcut). 

¶ Write your own batch script that adds OpenJDK bin subfolder to PATH variable and calls Eclipse (out of scope of 

this document). 

¶ Write your own batch script that calls Eclipse with appropriate - vm option (out of scope of this document). 
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Adding OpenJDK to Windows Path 

After the OpenJDK files are extracted to an installation folder, consider adding its bin  subfolder to Windows system or 

user PATH environment variable. Add OpenJDK to the system PATH if you want all users to be able to use it. Add it to 

the user PATH otherwise. 

For example, add C: \ Program Files \ OpenJDK\ jdk - 11\ bin  to the system PATH variable. In the case of 

Windows 10, the Edit environment variable window will look like this 

 

 

In the case of legacy Windows, the Edit System Variable window will look like this 

   

If you need a detailed walkthrough, see Appendix 1 ς Modifying Windows Environment Variables. 

Access Environment Variables window, for example, by going to Windows Search -Ҕ άŜƴǾƛǊƻƴƳŜƴǘέ -> Edit the system 

environment variables -> System Properties -> Advanced -> Environment Variables. 

In the Environment Variables window, find existing system (or user) PATH variable or create new user PATH variable. 

Add the OpenJDK bin  folders to the path variable. 

Note - The user path is appended to the system path. In most cases, you need Cygwin to be added either to the system 

or to the user path variable.  
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Verifying OpenJDK in Windows Path 

To verify Windows path, launch a command line window. For example, find or open the Windows search box and click 

inside it, then search for cmd program. 

Windows 10 Legacy Windows 

 

 

  

 

 

 

Enter word cmd  in the search field. Click on cmd  in the list of found programs.  
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You will see Windows shell (command line) window. 

 

At the shell prompt, enter java  - version  command  and press Enter key. You are supposed to see OpenJDK 

version information . 

Note - there is a space between java  and - version  and one dash in the - version .  
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)ÎÓÔÁÌÌÉÎÇ %ÃÌÉÐÓÅ )$% 

Eclipse IDEɁ is an integrated development environment that can be used to develop programs in a variety of 

programming languages, including Java and C/C++. For a good summary, check WikipediaΩs  Eclipse (software)Ɂ 

webpage. 

¢ƘŜǎŜ ƛƴǎǘǊǳŎǘƛƻƴǎ ǿŜǊŜ ǇǊŜǇŀǊŜŘ ǿƘŜƴ ǘƘŜ ŎǳǊǊŜƴǘ 9ŎƭƛǇǎŜ ǾŜǊǎƛƻƴ ǿŀǎ ŎŀƭƭŜŘ άPhotonέΦ LŦ ȅƻǳ ŘƻǿƴƭƻŀŘ ƳƻǊŜ ǊŜŎŜƴǘ 

Eclipse version, you may see some differences between the actual installation process and the process described in 

these instructions. 

Selecting Eclipse Package 

Depending on your needs, select what Eclipse packages to install. In this document, the following packages and 

components are covered 

                                         Languages  

 

Packages         

Disk 

Space 

(MiB) 

ZIP 

Size 

(MiB) 

C and 

C++ 

Java Java and 

Java2 

Enterprise 

C, C++, and 

Java 

C, C++, Java, 

and Java2 

Enterprise 

Eclipse IDE for Java Developers 230 190  Yes  Yes  

Eclipse IDE for Java EE Developers  
* includes IDE for Java Developers 

418 339   Yes  Yes 

C/C++ Development Toolkit (CDT)1   58     -    Yes1 Yes1 

Eclipse IDE for C/C++ Developers  
* includes C/C++ Development Toolkit 

331 223 Yes     

Total Disk space (MiB)   331  230  418  288 476 

 

The total disk space mentioned above does not include space needed to store the downloaded Eclipse ZIP archives. Also 

note that you can install multiple packages at the same time as long as each package is installed in a separate folder. 

You can see more information about available Eclipse packages on Compare Eclipse PackagesɁ webpage. Eclipse 

packages consist of dozens of smaller components that can be combined and mixed. Such components can be called 

Eclipse add-ons, plugin, or just software items. If you decide to install additional Eclipse components, Installing CDT Add-

on section and Appendix 4 ς Managing Eclipse Software provide some examples. 

For instance, you can install Eclipse IDE for Java Developers first and then add C/C++ Development Tooling to it (see 

Installing CDT Add-on section). Or you can install Eclipse IDE for C/C++ Developers first and then add Java Development 

Tooling to it (out of this document scope). In both cases, you will get Eclipse IDE capable of Java and C/C++ development. 

Note 1 - C/C++ Development Tooling (CDT) is an add-on to Eclipse. If a mixed C/C++ and Java development is required, 

install Eclipse IDE for Java (or Java EE) first and CDT add-on second. 

Note 2 - To run Java Enterprise programs an appropriate Java Enterprise Application Server is required (that is out of this 

document scope). 

https://www.eclipse.org/
https://en.wikipedia.org/wiki/Eclipse_(software)
https://www.eclipse.org/downloads/packages/compare
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Eclipse Installation  Folder 

Decide where you want Eclipse to be installed to (the installation folder). You have two choices 

1. If you are going to use Eclipse and nobody else ς install it in your data directory, for example, 

C: \ Users \ Richard \ Eclipse \ java - 2018 - 09 . You will not need an administrator access to manage Eclipse 

in this case. 

2. If other users are going to use Eclipse ς install it in the program folder or some other shared folder, for example, 

C: \ Program Files \ Eclipse \ cpp - 2018 - 09 . In this case, some Eclipse management will have to be 

performed using administrator access, specifically, (a) editing eclipse.ini  file, (b) initializing Eclipse data, (c) 

installing Eclipse software, and (d) updating Eclipse. 

The table below describes the destination folder selection. Substitute your actual username for username and 

appropriate installation name for java-2018-09.  

 If you are going to use Eclipse and nobody else If other users are going to use it 

Windows 

64-bit & 

Eclipse 

64-bit 

C: \ Users \ username \ eclipse \ installation  C: \ Program Files \ Eclipse \ installation  

 

You can have multiple Eclipse packages and their versions installed, just use unique installation names.  

For example, you can have java - 2018 - 09  and java - photon . If you want to keep Java and C/C++ Eclipse 

installations separate, you can have java - 2018 - 09  and cpp - 2018 - 09 . Or you can have common installation 

eclipse - 2018 - 09 . 

Note ς Usually the installation folder has exactly one eclipse  subfolder that contains all Eclipse files. For example, 

C: \ Users \ Richard \ Eclipse \ java - 2018 - 09\ eclipse . Sometimes, in Eclipse documentation, this subfolder 

ƛǎ ŎŀƭƭŜŘ άǊƻƻǘ ŦƻƭŘŜǊέΣ ƛǘ Ƴŀȅ ōŜ ŀƭǎƻ ŎŀƭƭŜŘ άƛƴǎǘŀƭƭŀǘƛƻƴ ŦƻƭŘŜǊέΦ  

Lǘ Ƴŀȅ ōŜ ŎƻƴŦǳǎƛƴƎΣ ōǳǘ ŦǊƻƳ ǘƘŜ ŎƻƴǘŜȄǘ ƛǘ ǎƘŀƭƭ ōŜ Ŝŀǎȅ ǘƻ ŘƛǎǘƛƴƎǳƛǎƘ ƛŦ άƛƴǎǘŀƭƭŀǘƛƻƴ ŦƻƭŘŜǊέ ǊŜŦŜǊǎ ǘƻ 

C: \ Users \ Richard \ Eclipse \ java - 2018 - 09  or C: \ Users \ Richard \ Eclipse \ java - 2018 -

09\ eclipse . 
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Eclipse Oomph Installer 

Using Eclipse Oomph InstallerɁ is the recommended way to install Eclipse. The installer makes it easier to select Eclipse 

software, download it, install it, adjusts some settings, etc.  

Another option is to download and unpack Eclipse ZIP archive. If you are interested in it, see Appendix 16 ς Installing 

Eclipse via ZIP Archive. 

Downloading Eclipse Oomph Installe r  

In your browser open www.eclipse.orgɁ 

 

Click on orange 
 

download button. 

 

https://wiki.eclipse.org/Eclipse_Installer
http://www.eclipse.org/
https://www.eclipse.org/downloads/
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You will see Download Eclipse TechnologyɁ page 

 
 

Click on orange 
 

download button. 

 

https://www.eclipse.org/downloads/
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You will see Eclipse Installer 2018-09 DownloadɁ page (or similar page) 
 

 
 

Click on orange 
 

download button. 

  

Depending on your browser, you will get a download prompt.  Download and run the file. See Appendix 11 ς 

Downloading and Running files from the Internet if you need help with the file downloading. 

https://www.eclipse.org/downloads/download.php?file=/oomph/epp/2018-09/R/eclipse-inst-win64.exe
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Simple vs Advanced Mode 

When Eclipse Oomph Installer is started the first time, it runs in so called simple mode. If needed, the installer can be 

restarted in advanced mode. 

Here is a summary of differences between the simple and advanced modes. 

Feature Simple Advanced 

Eclipse shall be used only by the user that installs it  ṉ  

Create Eclipse desktop shortcut Ä  

Create Eclipse menu entry Ä  

Select Eclipse installation folder Ä Ä 

Select Eclipse product Ä Ä 

Eclipse installation can be shared between users  Ä 

Select Eclipse product version  Ä 

Select Eclipse bitness (63-bit or 32-bit)  Ä 

Install Eclipse projects  Ä 

Select Java virtual machine to run Eclipse  Ä 

Select bundle pool (shared Eclipse files)  Ä 

Configure network proxy settings  Ä 

Configure SSH settings  Ä 

Review and adjust proposed configuration changes  Ä 

Installation messages log  Ä 

In some cases, the installer has to be run as Administrator  ṉ 

 

The simple mode is illustrated in Eclipse Installer in Simple Mode section, the advanced mode explained in Appendix 7 ς 
Eclipse Installer in Advanced Mode. 
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Running Eclipse I nstaller the First Time  

If you did not ask the browser to run the downloaded file, find Eclipse Oomph Installer executable (eclipse - inst -

win64.exe ) in the file explorer and run it. 

 

 
 

If you see the following pop-up window, 
 

 
 

it means that Java SE bin  subfolder is not in the Windows PATH environment variable. You have two choices 
 

¶ Press No button. Add Java SE bin  subfolder to the Windows PATH environment variable as described in section 
Adding OpenJDK to Windows Path. Start Eclipse Oomph Installer again. 

¶ Press Yes button. It will open a file browser window that you can use to locate appropriate Java SE virtual machine 
(specifically javaw.exe  file in Java SE bin subfolder). The installer will use this virtual machine to run itself and to 
configure Eclipse eclipse .ini  file, so Eclipse will use it also. See Appendix 2 ς Configuring Eclipse Lunch 
Properties (eclipse.ini) for more information. 
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You will see the following splash window 
 

 
 

If you are running the installer the first time, you will be asked to accept its license 

 

Review the license and press Accept Now button if you want to continue. 
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Eclipse Installer in Simple Mode  

When you run Eclipse installer in the simple mode, you will see a window similar to one below 

 
 

Select Eclipse package that you want to download and click on correspondent Windows 64-bit link. 

1. LŦ ȅƻǳ ǿŀƴǘ ǘƻ ǳǎŜ 9ŎƭƛǇǎŜ ŦƻǊ /κ/ҌҌ ŘŜǾŜƭƻǇƳŜƴǘ ƻƴƭȅΣ ǎŜƭŜŎǘ άEclipse IDE for C/C++ Developersέ 

2. If you want to use Eclipse for Java standalone program development and, possibly, C/C++ development, select 

άEclipse IDE for Java Developersέ 

3. If you want to use Eclipse for Java Enterprise development, possibly, for Java standalone program development, 

and, possibly, C/C++ development, selecǘ άEclipse IDE for Java EE Developersέ   

.Ŝƭƻǿ ƛǘ ƛǎ ŀǎǎǳƳŜŘ ǘƘŀǘ άEclipse IDE for Java Developersέ is selected. 
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You will see the following page 

 
 

Review the licenses. Check Remember accepted licenses box . Click Accept button  to continue. 
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You will see the following window 

 

 

Review the installation folder . If needed, enter a different name of or browse to a different folder . 

If you do not want the desktop shortcut or the menu entry created, uncheck the appropriate boxes.  

Press Install button  to continue. 
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You will see the installation progress window 

 

 

     

 

While installing Eclipse CDT, the installer may prompt for Eclipse code signing certificate confirmation. You will have to 

accept the certificate to continue.  

 

 

Review the certificate list (select a certificate and use Details button to see the certificate information). If you trust the 

certificate(s), check appropriate box(es)  and press Accept selected button . 

See Do you trust these certificates? in Appendix 13 ς Eclipse Pop-ups and Prompts for more details. 
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After the installation is completed, you will see the following window 

 

 

Close the window . How to launch Eclipse will be explained in further sections. 

Note ς if you are sure that Eclipse can find Java virtual machine, you may press Launch button .  
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Switching to Advanced Mode  

To switch to advanced mode, start Eclipse installer in simple mode. 

 

/ƭƛŎƪ ƻƴ άƘŀƳōǳǊƎŜǊέ ƛŎƻƴ  to open the installer menu. Click on !ŘǾŀƴŎŜŘ aƻŘŜΧ .  

See Appendix 7 ς Eclipse Installer in Advanced Mode for a detailed walkthrough. 
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Setting Up Eclipse Shortcut  

Having an Eclipse desktop shortcut (or a menu entry) makes launching Eclipse easier. By default, Eclipse installer in 

simple mode creates the shortcut (and the menu entry) automatically.  

If you uncheck the shortcut option in the installer, or if you run the installer in advanced mode, the installer does not 

create the shortcut.  

In such a case, you can create the shortcut manually. To do so, open the Eclipse installation directory in Windows 

Explorer, and go inside eclipse  subfolder. 

 

Move the mouse pointer over eclipse.exe  icon and click the right mouse button to open a context menu. 

Depending on you File Explorer settings, you may see eclipse.exe  or just eclipse  right to it. 

Select Copy from the menu. Find some empty space on your desktop, move the mouse pointer there, and click the right 

mouse button to open a context menu. Select Paste Shortcut from the menu. You will see a new shortcut eclipse icon 

ǿƛǘƘ άeclipse.exe ς Shortcutέ όƻǊ Ƨǳǎǘ άŜŎƭƛǇǎŜΦŜȄŜέύ ǳƴŘŜǊƴŜŀǘƘΦ 

Change the shortcut name to Eclipse Photon  (or something else). Move the mouse pointer over the new shortcut 

icon and click the right mouse button to open a context menu. Select Rename from the menu. Enter the shortcut name 

in the highlighted box end press Enter key. 

If you need more help, see section Creating Eclipse Desktop Shortcut in Appendix 6 ς Making Eclipse Shortcut. 

 

 

ố  The created shortcut will be added to the current user desktop. If you want the shortcut to be available for all users, 

move it to an appropriate folder, for example, to C: \ Users \ Public \ Desktop . 
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2ÕÎÎÉÎÇ %ÃÌÉÐÓÅ )$% ÔÈÅ &ÉÒÓÔ 4ÉÍÅ 

How Eclipse Launcher Locates Java Virtual Machine 

Usually, to start Eclipse people run so called Eclipse launcher (eclipse.exe ) via a shortcut, a script, Windows 

explorer, or a command line. The launcher determines what Java virtual machine to use and then starts the Eclipse 

application itself running in the machine. 

If you followed Enabling Eclipse Launching via OpenJDK section, you can skip to the next section. Otherwise read this 

section and enable one of the options described in the table.  

The Eclipse launcher searches Java virtual machines in the following locations, in the following order, starting at step 1. 

Step Location Option How to enable Comment 

1 - vm argument to 

eclipse.exe  program 

add - vm argument to the 

command line, for example, in 

Eclipse desktop shortcut 

see Using Shortcut Command Line to Specify 

Java Virtual Machine 

2 - vm argument in 

eclipse.ini  file 

edit eclipse.ini  file  see Appendix 2 ς Configuring Eclipse Lunch 

Properties 

3 9ŎƭƛǇǎŜ ƛƴǎǘŀƭƭŀǘƛƻƴΩǎ jre  

subfolder  

create jre  subfolder and copy 

Java SE files to it 

this subfolder is not a part of usual Eclipse 

installation 

4 Windows search path add Java bin  subfolder to PATH 

variable 

see PATH Environment Variable 

 
If you use one of the options and later decide to switch to another one, pay attention to the order in which locations are 

searched. For example, if you have a - vm argument in an eclipse.ini  file, added manually or automatically (by 

Eclipse Oomph installer), and you want to use PATH variable, the - vm argument has to be removed from the 

eclipse.ini  file. Otherwise, the - vm specified Java virtual machine will be used, not the machine found in the 
Windows path.  
 
Note 1 ς The Eclipse launcher does not use JAVA_HOME environment variable. 

Note 2 ς See Eclipse LauncherɁ for more details. 

 

 Before trying Eclipse launch, be sure to enable one of the options described in the table.  

 Pay attention to the order in which locations are searched, especially, if more than one is enabled. 

 

https://help.eclipse.org/photon/index.jsp?topic=%2Forg.eclipse.platform.doc.isv%2Freference%2Fmisc%2Flauncher.html
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Configuring Eclipse Lunch Properties  

Eclipse launcher uses properties configured in eclipse.ini  file that resides inside Eclipse installation folder. 

Sometimes, it might be necessary to change the properties, for example, to specify what Java virtual machine to use or 

how much memory to use.   

 

ố If you modify eclipse.ini  file while Eclipse is running, the Eclipse has to be restarted for the changes to take 

effect. 

 

 
If you use Eclipse Oomph installer, it may add Java SE bin  subfolder pathname to the eclipse.ini  file, as in the 
example below.  
 

 

If you want Eclipse to run under a different Java SE virtual machine, exit Eclipse, if running, and edit this file - change the 

pathname, as described in Appendix 2 ς Configuring Eclipse Lunch Properties (eclipse.ini), or remove these two lines 

completely. Additional details are provided in How Eclipse Launcher Locates Java Virtual Machine section later in this 

document. 
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Running Eclipse as Regular User vs Administrator  

Running Eclips e as Regular User 

If Eclipse is installed in a folder the user can write to (such as your user data folder) or if you are using Windows XP 

You can run Eclipse as regular user to install, update, and maintain Eclipse software. You may skip to  Launching 

Eclipse section in such a case. 

Running Eclipse as Administrator  

If you are using Windows other than Windows XP and Eclipse is installed in a folder that the user cannot write to, for 

example, C: \ Program Files  

You shall run Eclipse the first time as Administrator (to initialize it, see below) 

You have to run Eclipse as Administrator in order to be able to install and update Eclipse software.   

You shall use dedicated administrative workspace while running Eclipse. 

After Eclipse software is installed/updated, exit the Eclipse and start it again regular way.  

 

See When to Run Eclipse as Administrator in Appendix 4 ς Managing Eclipse Software for a walkthrough. 

Initializing Shared Eclipse Instal lation  as Administrator  

To improve Eclipse performance, if Eclipse is installed in a folder that the user cannot write to, for example 

C: \ Program Files \ Eclipse \ Photon , it is recommended to initialize Eclipse configuration data (such as 

caches).  

If Eclipse is installed in a folder the user can write to, such as your user data folder, there is no need to initialize the 

configuration data (though it is safe to do so). 

To initialize the data, it is enough to start Eclipse as Administrator, as described in the next section. While running 

Eclipse as Administrator, do software updates (if needed), fix Java SE 11 issues (if needed), install CDT Add-on (if 

needed). After it, exit Eclipse and then start it again as regular user. 

Note ς You can also initialize the data if you run eclipse.exe  with - initialize  option as Administrator. If you 

are interested in this option, see Initializing Shared Eclipse Installation via Command Line in Appendix 4 ς Managing 

Eclipse Software.  



Installing Eclipse IDE on Windows for Java and C/C++ Developers  

© Copyright 2019 Alexander Murashkin            

Page 35 of 292 

Revision 20190205 

Launching  Eclipse 

If Eclipse Launcher is already Running  

You have to exit the launcher if it is running as regular user but you need it to run as Administrator, and vice versa. To 

exit the launcher, press Cancel button. 

If Eclipse Launcher is not yet Running  

If you are going to run Eclipse as regular user, 

If you have an Eclipse desktop shortcut, the Eclipse launcher can be started by double clicking on the shortcut. Or use 

Windows Explorer to find Eclipse launcher eclipse.exe  file and double click it. You can also open a command line 

window (cmd), change to the Eclipse installation directory, and call eclipse.exe  from there. 

 

If you are going to run Eclipse as Administrator, 

If you have an Eclipse desktop shortcut, the Eclipse launcher can be started by selecting Run as Administrator option 

from the context menu. Or use Windows Explorer to find Eclipse launcher eclipse.exe  file and select Run as 

Administrator option from the context menu. You can also open a command line window (cmd) as Administrator, 

change to the Eclipse installation directory, and call eclipse.exe  from there. 

Launcher Process 

The launcher will figure out what Java virtual machine to use if you added Java bin  subfolder to Windows path or 

enabled one of the options explained in Enabling Eclipse Launching via OpenJDK and  How Eclipse Launcher Locates Java 

Virtual Machine sections. 

Then the launcher will start the Eclipse application using the found Java virtual machine. 

When the launcher is running, you will see a splash window. 
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After the splash window you will see Eclipse IDE Launcher window.  

 

You can use the suggested workspace folder path. If you do not like it, enter whatever workspace folder path you prefer. 

The workspace folder contains all files related to your development projects (source code, data files, binary files, etc.). 

You can have multiple workspaces (for example, all java projects in one workspace, and C++ projects in another 

workspace). Each workspace has own set of preferences, so you can customize the workspaces to your needs.  

Selecting Workspace when Run as Regular User  

 

Enter the workspace folder name in Workspace field . For example, add \ Java to the pathname. Use Browse button 

 to select the folder, if needed. 

Press Launch button  to start the Eclipse. Press Cancel button  if you want to exit the Eclipse. 
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Selecting Workspace when Run as Administrator  

If the Eclipse is run as Administrator, we recommend creating a dedicated administrative workspace. 

 

Enter the administrative workspace folder name in Workspace field . For example, add \ Admin to the pathname. Use 

Browse button  to select the folder, if needed. 

Press Launch button  to start the Eclipse. Press Cancel button  if you want to exit the Eclipse. 

Note ς The workspace folder will be owned by Administrators. It shall be used for Eclipse software management and for 

testing. Some Eclipse functionality might not work if the workspace is used by a regular user. See When to Run Eclipse as 

Administrator section in Appendix 4 ς Managing Eclipse Software. 
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Starting Eclipse Application  

After Eclipse launcher figures out what Java virtual machine to use and what workspace to open, it starts the Eclipse 

application itself. 

You will see Eclipse application splash window. 

  

After few seconds you will see a welcome window. The specific window depends on the installed Eclipse variant ς 

Eclipse IDE for Java, Java EE, or C/C++ Developers. 

 

 

ố If you already have some instance of Eclipse installed and you are installing a different instance of Eclipse, you may be 

prompted to reinstall previously installed plugins when you run the new instance for the first time. In such a case, see 

Importing and Reinstalling Previously Installed Eclipse Plugins in Appendix 4 ς Managing Eclipse Software. Return 

here after you deal with the plugins reinstall. 
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When the Eclipse is finally started, you will see a Welcome (also called overview) pane similar to 

one below  

 

In this screenshot, the overview contains a mix of C/C++, Java, and PHP information because I installed C/C++ and PHP 

plugins in addition to basic Java Enterprise Eclipse variant. 

What you see in the Welcome pane depends on the Eclipse variant and additionally installed Eclipse software. 
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/ƭƛŎƪ ƻƴ άMinimizeέ ƛŎƻƴ  inside Eclipse window to minimize the Welcome pane. As a side effect 
other, previously minimized, elements of Eclipse interface will become visible. 
 

 

Sometimes, after the start, everything is minimized as in the example below 

 

Lƴ ǎǳŎƘ ŀ ŎŀǎŜΣ ŎƭƛŎƪ ƻƴ άRestoreέ ƛŎƻƴ  inside Eclipse window to restore (unminimize) it. 
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First Software Update 

If you used Eclipse Oomph Installer, there is no need to update the software at this point (the installer does it 

automatically).  Skip to the next section in such a case. 

If you used ZIP archive to install Eclipse, after Eclipse is installed and run the first time, it is recommended to update the 

Eclipse software. See Updating Eclipse Software (in Appendix 4 ς Managing Eclipse Software) for the detailed 

walkthrough. 

 

 

ṉ If you are using Windows other than Windows XP and Eclipse is installed in a folder that the user cannot write to (for 

example, inside C: \ Program Files ), you have to run Eclipse as Administrator in order to be able to install and 

update Eclipse software. See When to Run Eclipse as Administrator  (in Appendix 4 ς Managing Eclipse Software) for 

more details. 

ṉ To be able to install and update software, Eclipse requires an Internet access. By default, Eclipse uses the same 

settings as Edge and Internet Explorer browsers, so, if you can browse the Internet via these browsers, you, very 

probably, will be able to use install and update features in Eclipse. See Appendix 3 ς Configuring Eclipse for Internet 

Access if you are having Internet connectivity problems in Eclipse. 

 

 

If needed, close Eclipse, start it again as Administrator, and select administrative workspace.  

Open Help menu and select Check for updates. If the updates are found, Eclipse will display Available Updates window.  

Be sure that all desired updates are selected and press Next button. Review the list of updates one more time, press 

Next button again to continue. Review the licenses, check I accept the terms of the license agreements, and press 

Finish button to continue. 

Finally, after the software is updated, you will see a prompt asking to restart Eclipse. Press Restart Now button and wait 

until the Eclipse is restarted.  

If Eclipse is running as Administrator and you do not intend to install any additional Eclipse software - press No button 

instead, exit Eclipse, and start Eclipse again in regular way, if needed. 
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Java SE 11 Issues  

If Java SE 11 is used to run Eclipse IDE for Java Developers, you may experience issues mentioned in this section. It is also 

possible that the issues are resolved in the Eclipse version that you use. 

How to check and fix the issues is described below. 

Note - If you used ZIP archive to install Eclipse, try first to update Eclipse software as described in the previous section.  

 Ȭ&ÅÁÔÕÒÅÓ ÍÁÙ ÎÏÔ ×ÏÒË ÁÓ ÅØÐÅÃÔÅÄȭ )ÓÓÕÅ 

If Java SE 11 is used to run Eclipse IDE for Java Developers, you may see warning message ά¸ƻǳ ǎŜƭŜŎǘŜŘ ŀ Ww9 ǘƘŀǘ ǘƘƛǎ 

ǾŜǊǎƛƻƴ ƻŦ 9ŎƭƛǇǎŜ W5¢ ŘƻŜǎ ƴƻǘ ȅŜǘ ǎǳǇǇƻǊǘ ŦǳƭƭȅΦ {ƻƳŜ ƻŦ ǘƘŜ ŦŜŀǘǳǊŜǎ Ƴŀȅ ƴƻǘ ǿƻǊƪ ŀǎ ŜȄǇŜŎǘŜŘΦέ 

You can disregard this message if you are not going to use Java SE 11 new features in your source code. See Java 11 

Support in EclipseɁ for more information about the features.  If you want to use them, install Eclipse software items as 

detailed in Installing Java SE 11 Support Patch section. 

 

To check if you have this issue, in Eclipse, open Window menu and select Preferences option. 

https://wiki.eclipse.org/Java11/Examples
https://wiki.eclipse.org/Java11/Examples
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You will see Eclipse preferences window. 

 

Click on a small white triangle (or angle ) ƭŜŦǘ ǘƻ άJavaέ ǘƻ ƻǇŜƴ Java preferences. If you do not see the (tri)angles, 

move the mouse pointer to the left (white) panel and the (tri)angles will appear. 

 

In the Java preferences , select Installed JREs . 

You have the issue if you see the warning  ά¸ƻǳ ǎŜƭŜŎǘŜŘ ŀ Ww9 ǘƘŀǘ ǘƘƛǎ ǾŜǊǎƛƻƴ ƻŦ 9ŎƭƛǇǎŜ W5¢ ŘƻŜǎ ƴƻǘ ȅŜǘ ǎǳǇǇƻǊǘ 

ŦǳƭƭȅΦ {ƻƳŜ ƻŦ ǘƘŜ ŦŜŀǘǳǊŜǎ Ƴŀȅ ƴƻǘ ǿƻǊƪ ŀǎ ŜȄǇŜŎǘŜŘέ. 

Press Cancel button  to close the preferences. 
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Install ing Java SE 11 Support  Patch 

 

 

ṉ If you are using Windows other than Windows XP and Eclipse is installed in a folder that the user cannot write to (for 

example, inside C: \ Program Files ), you have to run Eclipse as Administrator in order to be able to install and 

update Eclipse software. See When to Run Eclipse as Administrator  (in Appendix 4 ς Managing Eclipse Software) for 

more details. 

ṉ To be able to install and update software, Eclipse requires an Internet access. By default, Eclipse uses the same 

settings as Edge and Internet Explorer browsers, so, if you can browse the Internet via these browsers, you, very 

probably, will be able to use install and update features in Eclipse. See Appendix 3 ς Configuring Eclipse for Internet 

Access if you are having Internet connectivity problems in Eclipse. 

 

 

 
If needed, close Eclipse (open File menu and select Exit option), start it again as Administrator, and select administrative 
workspace.  
 

 

Open Help menu  and select Install Additional Software option . 
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You will see Available Software window 

 

On the Available Software page, press Manage button. 
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You will see Available Software Sites preferences. 

 

Press Add button to add a new software site. It will open Edit Site pop-up window. 

 

In the Name field  enter 

Java 11 Support  

In the Location field  enter 

http://download.eclipse.org/eclipse/updates/4.9 - P- builds  

Press Add button  to add the site and to close the pop-up window. 
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You will see an updated list of software sites. 

 
 
Press Apply and Close button to save and close the preferences. 

You will be returned to the Available Software window. 

 

Open  the drop-down list of software sites. Select Java 11 Support site . 
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Wait until the software list is processed. 
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Click on white triangle (or angle ) left to Eclipse Java 11 ǎǳǇǇƻǊǘΧ  to open a list of software items in the group.  

Check 9ŎƭƛǇǎŜ W5¢ όWŀǾŀ 5ŜǾŜƭƻǇƳŜƴǘ ¢ƻƻƭǎύ tŀǘŎƘ ǿƛǘƘ WŀǾŀ мм ǎǳǇǇƻǊǘΧ item . Press Next button  to continue. 
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Press Next button (if there is no Next button but there is Finish button, press Finish button). 

 

Review the license and select option L ŀŎŎŜǇǘΧ . Press Finish button to proceed. The installation progress status will 
be displayed at the Eclipse main window bottom. 
 

 
 
Wait until the software is installed. 
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Press Restart Now button  and wait until the Eclipse is restarted if 

¶ Eclipse is running as regular user and the current workspace is to be used for Java development 

¶ Or Eclipse is running as administrator and you intend to do more Eclipse software management as administrator 

Otherwise press No button  instead, exit Eclipse, and start Eclipse again (and create Java dedicated workspace, if so 

desired). 

Note ς As long as Java 11 Support site is enabled in Available Software Sites preferences, the Java 11 patch will be 

shown in the list of available updates every time, does not matter that it is already installed. It is annoying but harmless. 

To remove the patch from the list, disable (uncheck) Java 11 Support site in the preferences.  

Eclipse is (Almost) Done 

I you installed Eclipse for Java (or Java EE), at this point, the Eclipse is (almost) ready for Java (and, possibly, Java EE) 

development but not for C/C++ development.  

¶ If you want to develop C/C++ programs, C/C++ Development Tool kit (CDT) add-on has to be installed proceed to 

Installing Eclipse C/C++ Development Tooling (CDT) section below. 

¶ Otherwise proceed to Eclipse IDE Basics section. 

If you installed Eclipse IDE for C/C++ Developers, at this point, the Eclipse is (almost) ready for C/C++ development but 

not for Java development.  

¶ You still need to install Cygwin (or another build system) to be able to compile, link, run, and debug C/C++ 

applications. Proceed to Installing Cygwin section. 

¶ If you want to develop Java programs, Java Development Tool kit (JDT) add-on has to be installed. The 

installation of JDT add-on is out of scope of this document. It, though, is very similar to installation of CDT add-

on described below in Installing Eclipse C/C++ Development Tooling (CDT) section. 
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)ÎÓÔÁÌÌÉÎÇ %ÃÌÉÐÓÅ #Ⱦ#ϹϹ $ÅÖÅÌÏÐÍÅÎÔ 4ÏÏÌÉÎÇ ɉ#$4Ɋ 

Eclipse C/C++ Development Tooling (CDT)Ɂ is an add-on to Eclipse IDE. It is a part of Eclipse IDE for C/C++ Developers, so 

you do not need to install CDT if Eclipse IDE for C/C++ Developers is installed. 

If you have Eclipse IDE variant other than Eclipse IDE for C/C++ Developers and want to do C/C++ development, you will 

have to install CDT add-on.  

CDT add-on consists of multiple Eclipse plugins, the recommended minimum is listed below (It will take approximately 

58 MiB of disk space). 

¶ ά/κ/ҌҌ 5ŜǾŜƭƻǇƳŜƴǘ ¢ƻƻƭǎέ 

¶ ά/κ/ҌҌ [ƛōǊŀǊȅ !tL 5ƻŎǳƳŜƴǘŀǘƛƻƴ IƻǾŜǊ IŜƭǇέ 

¶ ά/κ/ҌҌ ¦ƴƛǘ ¢ŜǎǘƛƴƎ {ǳǇǇƻǊǘέ 

¶ άTM Terminalέ 

¶ άMylyn Context Connector: C/C++ Developmentέ 

For a complete list of software items in CDT add-on, see Appendix 10 ς List of Software Items included in Eclipse CDT. 

Review them and install as needed. 

 

 

ṉ If you are using Windows other than Windows XP and Eclipse is installed in a folder that the user cannot write to (for 

example, inside C: \ Program Files ), you have to run Eclipse as Administrator in order to be able to install and 

update Eclipse software. See When to Run Eclipse as Administrator  (in Appendix 4 ς Managing Eclipse Software) for 

more details. 

ṉ To be able to install and update software, Eclipse requires an Internet access. By default, Eclipse uses the same 

settings as Edge and Internet Explorer browsers, so, if you can browse the Internet via these browsers, you, very 

probably, will be able to use install and update features in Eclipse. See Appendix 3 ς Configuring Eclipse for Internet 

Access if you are having Internet connectivity problems in Eclipse. 

 

 

https://www.eclipse.org/cdt/
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Installing CDT Add-on 

If needed, close Eclipse (open File menu and select Exit option), start it again as Administrator, and select administrative 

workspace.  

In the Eclipse window, open Help menu, select Install New Software option.  
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You will see Available Software window 

  

Check Hide items that are already installed  if it is not checked already.  Click small (tri)angle left to Add button  to 

open a menu ƻŦ ǎƻŦǘǿŀǊŜ άǎƛǘŜǎέ.  



Installing Eclipse IDE on Windows for Java and C/C++ Developers  

© Copyright 2019 Alexander Murashkin            

Page 55 of 292 

Revision 20190205 

 

Select All Available Sites option and wait. It may take few minutes for Eclipse to process required data.  



Installing Eclipse IDE on Windows for Java and C/C++ Developers  

© Copyright 2019 Alexander Murashkin            

Page 56 of 292 

Revision 20190205 

Selecting Software Items to Install  

 

 

Scroll down until you see Programming Languages group. Click on white triangle (or angle ) ƭŜŦǘ ǘƻ άProgramming 

Languagesέ to open a list of software items in the group. 
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If you are installing Eclipse Photon (or Juno, or any later version) check items listed below 

 ά/κ/ҌҌ 5ŜǾŜƭƻǇƳŜƴǘ ¢ƻƻƭǎέ 

ά/κ/ҌҌ Library API Documentation Hover Helpέ 

ά/κ/ҌҌ ¦ƴƛǘ ¢ŜǎǘƛƴƎ {ǳǇǇƻǊǘέ 

If you are installing Eclipse Indigo check items listed below  

άC/C++ Development Toolsέ 

άC/C++ Library API Documentation Hover Helpέ 

If some item is mentioned twice, select one that has newer version.  
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Scroll up until you see General Purpose Tools group. Click on white triangle (or angle ) left to it 

to open a list of general software. 

 

 

/ƘŜŎƪ άTM Terminalέ item if you see it. By default, already installed items are not shown. {ƻΣ ƛŦ ȅƻǳ Ŏŀƴƴƻǘ άTM 

Terminalέ ƛǘŜƳΣ ƛǘ ƛǎ ŀƭǊŜŀŘȅ  ƛƴǎǘŀƭƭŜŘΦ 

Scroll up until you see Collaboration group. Click on white triangle left (or angle ) to it to open a list of collaboration 

software. 

 

CheŎƪ άMylyn Context Connector: C/C++ Developmentέ item.  
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You can also search for software. For example, if you enter C++ in the search field, after some delay, Eclipse will display 

C++ related items (can be slow).   

 

Select additional items, as desired. 
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Finishing  CDT Installation  

 

 

When all needed items are selected, press Next button to proceed with the installation.  
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It is possible that some of the selected software items cannot be installed (for example, C/C++ Call 

Graph Visualization is not available for Windows). In such a case, ȅƻǳ ǿƛƭƭ ƎŜǘ άInstall Remediation Pageέ ŀǎ ōŜƭƻǿ 

(otherwise just skip to the next page). 

 

LŦ ȅƻǳ ǎŜƭŜŎǘ ƻǇǘƛƻƴ άYŜŜǇ Χέ  and press Next button , the wizard will install items that it can. You can also press 
Back button to return to the previous wizard page and change the list of items there. 
{ŜƭŜŎǘƛƴƎ ƻǘƘŜǊ ƻǇǘƛƻƴ ōǳǘ άYŜŜǇΧέ  is outside of this document scope. 
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You will see Install Details window. 

 

Inspect the list one more time and press Next button to continue (or Cancel button to stop the installation). 

You will see Review Licenses window. 

  

Review the licenses. Check I accept the terms of the license agreements  and press Finish button  to continue (or 

press Cancel button to stop the installation). 
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At the bottom of thŜ Ƴŀƛƴ 9ŎƭƛǇǎŜ ǿƛƴŘƻǿΣ ȅƻǳ ǿƛƭƭ ǎŜŜ ǇǊƻƎǊŜǎǎ ƳŜǎǎŀƎŜ άLƴǎǘŀƭƭƛƴƎ {ƻŦǘǿŀǊŜ Χέ 

 

Wait until the installation is completed.   

If some software is unsigned (by its developers), you may see various security prompts. See Appendix 13 ς Eclipse Pop-

ups and Prompts for more details. 

Finally, after the plugins are installed, you will see a prompt asking to restart Eclipse. 
 

 

 

Press Restart Now button  and wait until the Eclipse is restarted if 

¶ Eclipse is running as regular user and the current workspace is to be used for Java development 

¶ Or Eclipse is running as administrator and you intend to do more Eclipse software management as administrator 

Otherwise press No button  instead, exit Eclipse, and start Eclipse again (and create Java dedicated workspace, if so 

desired). 
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ố You may be prompted to reinstall previously installed plugins when you start Eclipse. In such a case, see Importing 

and Reinstalling Previously Installed Eclipse Plugins in Appendix 4 ς Managing Eclipse Software. Return here after you 

deal with the plugins reinstall. 

 

 

Wait until the main Eclipse window appears.  If everytƘƛƴƎ ƛǎ ƳƛƴƛƳƛȊŜŘΣ ŎƭƛŎƪ ƻƴ άRestoreέ ƛŎƻƴ  inside Eclipse window 

to restore (unminimize) it. 

  

Eclipse CDT is installed, but you need to configure it before using. 

Lƴ ǘƘƛǎ ǎŎǊŜŜƴǎƘƻǘΣ ȅƻǳ Ŏŀƴ ǎŜŜ ǘƘŀǘ ǘƘŜ 9ŎƭƛǇǎŜ ǿƛƴŘƻǿ ǘƛǘƭŜ ƛǎ άCPP2 ς JavaέΦ Lǘ is just an example. In the title, CPP2 is 

the workspace name and Java is the perspective name. When you do C/C++ development, you will, probably use C/C++ 

perspective (as described later in section  Opening C/C++ Perspective). 
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)ÎÓÔÁÌÌÉÎÇ #ÙÇ×ÉÎ 
Cygwin development packages are required in order to be able to compile, link, build, run, and debug C/C++ programs. 

You will need approximately 10 GiB of disk space to install all Cygwin development packages (you can reduce the disk 

space by not installing unnecessary development packages). You also will need around 1.9 GiB of temporary disk space 

to store downloaded Cygwin packages. 

Downloading Cygwin Setup Program  

In a browser, open www.cygwin.comɁ website. 

 

Click on setup-x86_64.exeɁ URL (see Cygwin 32-bit if you are running 32-bit Windows). Depending on your browser, 

you will get a download prompt.  Download and run the file. See Appendix 11 ς Downloading and Running files from the 

Internet for more information. 

http://www.cygwin.com/
http://cygwin.com/setup-x86_64.exe
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Running Cygwin Setup Program 

When you run the downloaded Cygwin setup program, you will see the following window. 

  

Press Next button to continue. 

  

.Ŝ ǎǳǊŜ ǘƘŀǘ άInstall from Internetέ ƻǇǘƛƻƴ ƛǎ ǎŜƭŜŎǘŜŘΦ  tǊŜǎǎ Next button. 
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The next screen will ask to select root install directory. 

  

Default settings are OK. By default, Cygwin is installed in C: \ cygwin64  on 64-bit Windows. You can change this path 

in the Root Directory field  if you prefer Cygwin files to be installed in another folder. Press Next button  to 

continue. 
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You, probably, will want to change Local Package Directory field . The folder will be used to store so called package 

files. These package files are used to install Cygwin features; they are not needed after the installation.  

For example, click right to the highlighted folder path  and edit it so the packages go to 

C: \ Users \ user name\ Dowloads \ Cygwin . Press Next button . 

You can keep these files if you expect to reinstall Cygwin or to install Cygwin on a different computer. Or you can 

remove the folder after Cygwin is installed. 

If the directory does not exist, you will see a pop-up window asking to confirm the directory creation. 

 

Press Yes button.  
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You will see the following window 

 

If you want Cygwin setup to use the same Internet connectivity settings as Windows, select Use System Proxy Settings 

option and press Next button. 

 

If you want Cygwin setup to access the Internet directly, select Direct Connection option and press Next button. 
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If you want Cygwin setup to use some specific proxy ς select Use HTTP/FTP Proxy, enter the proxy name (or address) in 

Proxy Host field, the proxy port in Port  field, and press Next button. Note that the proxy information above is just an 

example; you have to enter your proxy host and port. 

After you selected the Internet connectivity option and pressed Next button, you will see a window with a list of Cygwin 

download sites. The specific list may vary. 
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Select at least one of the Available Download Sites - click on a site name . If you want, you can 

select multiple download sites by clicking on a site name while CTRL key is pressed. The sites in the screenshot are just 

an example, select your own one or more sites. 

Press Next button  to continue.  

You will see a progress window. 

 

Wait until the next window appears. If you are installing Cygwin the first time, you may see a pop-up window asking to 

check Cygwin documentation ς click OK button to dismiss the window. 
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Selecting what Packages to Install  

After a list of Cygwin packages is downloaded, you will see Select Packages window below (possibly maximized, if you 
want the window be a normal size, click on Restore Down icon in the top right corner of the window). In the window, 
select what packages to install.  
 
By default, Cygwin setup will install only the packages in the Base category and their dependencies, resulting in a 
minimal Cygwin installation.  

Unfortunately, Cygwin setup interface is confusing in this case. Look for word after circular arrows . 

¶ Default means that Cygwin setup will decide whether to install the packages.  

¶ Install means that the packages will be installed. 

¶ Uninstall means that the packages will be uninstalled (if installed) or not installed at all. 

¶ Skip means leave the package as-is (do not install or uninstall it). 

Be sure to select Install for development packages. 

 

Click on circular arrows right of Devel category ς if you click successfully, word Default will be changed to word 

Install. If you make a mistake you can click on the circular arrow again. 
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You can click plus sign icon left of Devel category to see what packages are selected to be installed.  

 

If you like you can add more packages or remove unneeded packages. It is recommended to remove subversion-httpd 

package (if it is in the list). To do so scroll down until you see the package  
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Click few times on circular arrows  until you see word Skip instead of the version number. If you make a mistake, you 

can click on the circular arrow again. 

 



Installing Eclipse IDE on Windows for Java and C/C++ Developers  

© Copyright 2019 Alexander Murashkin            

Page 75 of 292 

Revision 20190205 

 

When you are satisfied with the packages selection press Next to continue.  
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Installing Selected Packages 

Cygwin setup will check for dependencies and will ask you to confirm that you want to install the dependencies 

(additional packages). 

 

Press Next button to continue.  
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You will see a window indicating that the packages are being downloaded and verified. 
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After the packages are downloaded and verified, you will see an installation progress window. 

 

 

Wait until the download and the installation are completed, it can take a long time (for example, an hour). 
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At the end, you will see the following window 

 

Confirm that the installation status is the Installation Complete . Check boxes to create Cygwin icon on desktop and 

add the icon to start menu . Press Finish button  to exit Cygwin setup program. 
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Verifying Cygwin Installation  

To verify that Cygwin is installed correctly, open Windows Start Menu and find Cygwin64 Terminal program (in legacy 

Windows, open All Programs submenu and open Cygwin submenu). 

Windows 10 Legacy Windows 

 

 

 

Select Cygwin64 Terminal (or just Cygwin Terminal). 
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After few seconds you are supposed to see either the following window (if you have not used 

Cygwin shell previously) 

 

or the window below (if you used Cygwin shell previously) 

 

 

Enter gcc -- version  command at the shell prompt  and press Enter key. 

 

You are supposed to see GCC compiler version and license information . You can close the shell window if you do not 

need it.   

Note 1 - There is a space between gcc  and -- version  and two dashes in the -- version .  

Note 2 - This verifies that a Cygwin shell window can be opened and that the GCC compiler can be invoked from the 

Cygwin shell. It does not verify that the compiler can be invoked from other Windows programs such as Windows 

command line shell or Eclipse itself. See Verifying Cygwin in Windows Path below. 



Installing Eclipse IDE on Windows for Java and C/C++ Developers  

© Copyright 2019 Alexander Murashkin            

Page 82 of 292 

Revision 20190205 

Enabling Cygwin Launching via Eclipse 

To be able to execute Cygwin programs from Eclipse, Eclipse has to know Cygwin installation folder path. Here are some 

possible ways to achieve it 

¶ Add Cygwin bin  subfolder to Windows PATH environment variable (described below). 

¶ Write your own batch script that adds Cygwin bin  subfolder to PATH variable and calls Eclipse (out of scope of 

this document). 

¶ Configure Cygwin build toolchain in Eclipse C/C++ preferences (out of scope of this document). 

Adding Cygwin to Windows Path  

After the Cygwin packages are installed, consider adding Cygwin bin  subfolder to Windows system or user PATH 

environment variable. Add Cygwin to the system path if you want all users to be able to use it. Add it to the user path 

otherwise. 

For example, add C: \ cygwin64 \ bin  to the system PATH variable. In the case of Windows 10, the Edit environment 

variable window will look like this 

 

 

In the case of legacy Windows, the Edit System Variable window will look like this 

   

If you need a detailed walkthrough, see Appendix 1 ς Modifying Windows Environment Variables. 

Access Environment Variables window, for example, by going to Windows Search -Ҕ άŜƴǾƛǊƻƴƳŜƴǘέ -> Edit the system 

environment variables -> System Properties -> Advanced -> Environment Variables. 
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In the Environment Variables window, find existing system (or user) PATH variable or create new 

user PATH variable. Add the Cygwin bin  subfolder to the path variable. 

Note - The user path is appended to the system path. In most cases, you need Cygwin to be added either to the system 

or to the user path variable.  
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Verifying Cygwin in Windows Path  

To verify Windows path, launch a command line window. For example, find or open the Windows search box and click 

inside it, then search for cmd program. 

Windows 10 (Desktop) Legacy Windows (Windows Start Menu) 

 
 

 

 

 

 
 

 

 

 

 

Enter word cmd  in the search field. Click on cmd  in the list of found programs.  
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You will see Windows shell (command line) window. 

 

At the shell prompt, enter gcc -- version  command  and press Enter key. You are supposed to see GCC compiler 

version and license information . 

Note 1 - there is a space between gcc  and -- version  and two dashes in the -- version .  

Note 2 - This verifies that the GCC compiler can be invoked from a Windows command line shell. If it fails, check that the 

GCC compiler can be invoked from a Cygwin shell as described in Verifying Cygwin Installation section previously. 

Restarting Eclipse  

A running Eclipse has to be restarted for the Cygwin related changes to take effect.  

If you are running Eclipse, open File menu and select Exit option. Launch Eclipse again. 
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%ÃÌÉÐÓÅ )$% "ÁÓÉÃÓ 

Eclipse Perspectives 

In Eclipse, a perspective is a set of views, editors, panels, etc. tailored for a specific task, for example, for Java 

development.  

You can use multiple perspectives with one Eclipse workspace, for example, Java and C++ perspectives. But only one of 

them can be visible inside any given Eclipse window.  

If you want so, you can have one Eclipse workspace for Java (with Java perspective opened) and one Eclipse workspace 

for C/C++ (with C/C++ perspective open). 
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5ÓÉÎÇ %ÃÌÉÐÓÅ ÆÏÒ *ÁÖÁ $ÅÖÅÌÏÐÍÅÎÔ 
If you are running Eclipse as Administrator or if the current workspace is not appropriate - exit Eclipse (open File menu 

and select Exit option), start it again as regular user, and select appropriate workspace. 

 Ȭ0ÏÌÌÉÎÇ ÎÅ×Ó ÆÅÅÄÓȭ 7ÏÒËÓÐÁÃÅ )ÓÓÕÅ 

 If this issue exists, it has to be fixed in each workspace. If it is a shared Eclipse installation, each user shall fix this issue 

ǿƘŜƴ ǘƘŜ ǳǎŜǊΩǎ ǿƻǊƪǎǇŀŎŜǎ ŀǊŜ ŎǊŜŀǘŜŘΦ  

 

If Java SE 11 is used to run Eclipse IDE for Java Developers, after the Eclipse is started, you may see the following pop-up 

window 

 

Press OK button to ignore the message. It is a known issue (see bug #540196Ɂ), it happens because javax.xml.bind 

package is not included in Java SE 11.  

The known workaround is to disable automatic news polling in Eclipse properties.  

 

To do so, in Eclipse, open Window menu and select Preferences option. 

https://bugs.eclipse.org/bugs/show_bug.cgi?id=540196
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You will see Eclipse preferences window. 

 

Click on a small white triangle (or angle ) ƭŜŦǘ ǘƻ άGeneralέ ǘƻ ƻǇŜƴ DŜƴŜǊŀƭ ǇǊŜŦŜǊŜƴŎŜǎΦ LŦ ȅƻǳ Řƻ ƴƻǘ ǎŜŜ ǘƘŜ 

(tri)angles, move the mouse pointer to the left (white) panel and the (tri)angles will appear. 

 

In the General preferences , select News . 

Uncheck option Enable automatic news polling . Press Apply and Close button  to save the preferences. 
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Opening Java Perspective 

You can open Java perspective if you installed Eclipse IDE for Java or Java EE Developers. 

If you see only Welcome pane,  

 

ŎƭƛŎƪ ƻƴ άRestoreέ icon to make the current perspective visible.  

 

Open Windows menu, select Open Perspective submenu, and select Java perspective. 
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You are supposed to see the Java perspective opened at this point. 

  

If you want so, you can minimize the Welcome ǇŀƴŜ ōȅ ŎƭƛŎƪƛƴƎ ƻƴ άMinimizeέ  icon in the panel title  or even close 

Welcome panel completely by clicking on άCloseέ   icon in the panel title .  

 

You can also remove Java EE perspective - move the mouse pointer over Java EE  icon , click the right mouse 

button to open a context menu, and select Close option . 
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In the example below, there is only one Java perspective and the welcome panel is closed. 

  

You can use Eclipse at this point to develop Java code. 
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Java Test Project 

Creating HelloJava Java Project 

To create a Java project, right click on an empty space in Package Explorer view to open a context menu. 

  

Select New submenu, select Java Project option. You will see New Java Project wizard window.  
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Enter HelloJava  text in the Project name field . Press Finish button  to create the project.  
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You will see HelloJava  project folder in the left panel. 

  

Creating Java Class 

Click on the white triangle (or angle ) icon left to HelloJava  to open the project folder. 

  

Right click on the src  subfolder name to open a context menu. 
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Open New submenu and select Class option. 
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Enter Main  word in the Name field . Check public static void main(String[] args) option . Press Finish button  

to create the project.  
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You will see Main.java source code opened in the middle editor pane. 

  

Editing Java Code 

Click inside the editor pane and start editing the source code. 

Remove the comment 

 // TODO Auto - generated method stub  

Type the following text instead of it 

System.out.println("Hello Java!!! \ n");  
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You are supposed to see the following 

 

Note asterisk sign *  left to Main.java  file name. The asterisk means that the file has been modified.  

Press floppy  icon to save the Main.java  file. 
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Running Java Program 

 

 

Be sure  that in the left pane Hello Java   project or any file or folder inside the project is highlited (Main.java  in the 

example). Otherwise you might get error messages down the road. 

¢ƻ Ǌǳƴ ǘƘŜ ǇǊƻƎǊŀƳ ŎƭƛŎƪ ƻƴ άǿƘƛǘŜ ǘǊƛŀƴƎƭŜ ƛƴǎƛŘŜ ƎǊŜŜƴ Řƛǎƪέ  icon (if you click on the triangle right to the icon 

you will see a menu that also can be used to run the project).  
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You are supposed to see Console view opened in the lower panel with Hello Java!!! text inside it.  

 

If Console view is not opened, click on Console tab to open it. If Console tab is missing, go to Window menu, select 

Show View submenu, and select Console option.  

Specifying Runtime Parameters  

If you want to specify program runtime parameters, for example, program arguments or environment variables, see 

Appendix 5 ς Program Run Configuration. Note that the default run configuration is created automatically the first time 

the program is run. 

 

 

     ThatΩǎ it! You have Eclipse Java Development Tools working! 
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5ÓÉÎÇ %ÃÌÉÐÓÅ ÆÏÒ #ϹϹ $ÅÖÅÌÏÐÍÅÎÔ 
If you are running Eclipse as Administrator or if the current workspace is not intended for C/C++ development - exit 

Eclipse (open File menu and select Exit option), start it again as regular user, and select appropriate workspace. 

C/C++ Specific Workspace Configuration 

To be able to debug C/C++ programs built using Cygwin toolset, it necessary to adjust some Eclipse preferences. Each 

workspace has own set of preferences. Run Eclipse as a regular user and select appropriate workspace that you use for 

C/C++ development. 

Cygwin uses own notation for file and folder names. For example,  

Windows folder name Cygwin folder name 

C: \  /cygdrive/c  

 

Because of this different naming convention, Eclipse debugger cannot find source files unless source file lookup rules are 

configured.  

 

To adjust the preferences, open Window menu and select Preferences option. 
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You will see Eclipse preferences window. 

 

Click on a small white triangle (or angle ) ƭŜŦǘ ǘƻ άC/C++έ ǘƻ ƻǇŜƴ /κ/ҌҌ ǇǊŜŦŜǊŜƴŎŜǎ. If you do not see the (tri)angles, 

move mouse pointer to the left (white) panel and the (tri)angles will appear. 

 

Click on a small white triangle (or angle ) left to έDebugέ group to open C/C++ debug preferences.  
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/ƭƛŎƪ ƻƴ άSource Lookup Pathέ ǘƻ ǎŜƭŜŎǘ {ƻǳǊŎŜ [ƻƻƪǳǇ tŀǘƘ ǇǊŜŦŜǊŜƴŎŜǎΦ 

 

Press Add ōǳǘǘƻƴΦ ¸ƻǳ ǿƛƭƭ ǎŜŜ άAdd Sourceέ ǇƻǇ-up window. 

  

Click on Path Mapping option  so it becomes selected. Press OK button . 
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 You will see Path Mapping window. 

  

 

Enter Cygwin  word in the Name field . Press Add button . 
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Find Compilation path column in the row that has icon at the left 

  

 

Enter \ cygdrive \ c  (no spaces) text in the compilation path field .  Click inside Local file system path column .

icon will appear. 
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/ƭƛŎƪ ƻƴ άΧέ box ƛŎƻƴΦ άSelect Folderέ ǇƻǇ-up window will open. 

  

For this mapping, you need to select C: \  folder. 
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Enter C: \  (no spaces) path in the Folder field . As soon as you enter the path you might see a menu opened with a 

list of suggested folders. Ignore the suggestions by clicking somewhere in grey area . 

  

Be sure that Folder field shows C: \  . Press Select Folder button to close the window. You are supposed to see the 

new mapping displayed. 
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If you keep all your development related files on C:  drive, you can press OK to close the window. 

If some of your development related files are on other drives, add similar pathes for all drives in use. For example, if you 

use drives D:  and E: , you shall add 2 more rules so the window will look like 

 

Press OK button when all pathes are added. You will be returned to the preferences window.  
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To verify that the path mapping is in place, click on white triangleicon (or angle ) left to Path Mappings: Cygwin.  

 

You are supposed to see the created path mappings .  Click OK button  to close the preferences window. 
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You have to restart Eclipse for the changes to take effect. Open File menu, select Restart option. Wait until Eclipse is 

restarted. 
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Opening C/C++ Perspective 

You may want to switch to a different workspace if you were using Eclipse to develop Java programs previously. To do so 

- exit Eclipse, run it again, and select appropriate workspace (or you can try to select appropriate workspace from File-

>Switch Workspace menu). 

You shall open C/C++ perspective (you can do it if you installed CDT as a part of Eclipse IDE for C/C++ Developers or as 

Eclipse add-on). 

You can open Java perspective if you installed Eclipse IDE for Java or Java EE Developers. 

If you see only Welcome pane,  

 

ŎƭƛŎƪ ƻƴ άRestoreέ icon to make the current perspective visible.  



Installing Eclipse IDE on Windows for Java and C/C++ Developers  

© Copyright 2019 Alexander Murashkin            

Page 112 of 292 

Revision 20190205 

 

Open Windows menu, select Open Perspective submenu, and select hǘƘŜǊ Χ option. 

In Open Perspective window 

 

 

click on C/C++ to select it. 
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Press OK Button.  

If you see Welcome pane and do not see any perspective opened, click on άRestoreέ icon to make the current 

perspective visible.  
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You are supposed to see so called C/C++ Perspective opened at this point. 

 

If you want so, you can minimize the Welcome ǇŀƴŜ ōȅ ŎƭƛŎƪƛƴƎ ƻƴ άMinimizeέ  icon in the panel title  or even close 

the Welcome panel completely by clicking on άCloseέ   icon in the panel title . 

 

You can also remove Java EE perspective - move the mouse pointer over άJava EEέ  icon , click the right mouse 

button to open a context menu, and select Close option . 
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Note that in the screenshot C++ Test2 is the workspace name and C/C++ is the perspective name. 
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Adding C/C++ Specific Views 

By default, you will see Project Explorer view . The project explorer can be used, but it is not tailored for C/C++ 

development. 

 

Open Windows menu, select Show View submenu, and select C/C++ Projects option. 
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You will see that C/C++ Projects view is shown in the left pane. 

 

You may close the Project Explorer view by right clicking on the view name and selecting Close option. The view always 

can be reopened later. 
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C++ Test Project 

Creating HelloWord C++ Project 

To create a C++ project, right click on empty space in C/C++ Projects view to open a context menu (you can also use 

main File menu). 

 

 Select New submenu, select C++ Project option.  
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You will see New C++ Project wizard window. 

 

Click on C++ Managed Build  to select it. Press Next button .  
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You will see C++ Project wizard. 

 

Enter HelloTest  text  in the Project name field. Click to select Hello World C++ Project  in the Project Type 

pane. Click to select Cygwin GCC  toolchain in the Toolchains pane. Press Finish button  to complete the project 

creation.  

If you press Next button (instead of Finish), you will see some advanced options (that are out of this document scope). 
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You will see the HelloTest.cpp  source code in the middle editor pane. If you see red error 

markers, wait until Eclipse completes the source code indexing. 

 

Click on a small white triangle (or angle ) left to HelloTest  folder to expand the folder. If you do not see the 

(tri)angle, move mouse pointer to the left (white) area and one will appear.  

Expand src  and Debug subfolders in similar way.  
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Building C++ Project  

At this point, you can build the project (compile the source code, link resulting object files, etc). 

 

Be sure that, in the left pane,  the current project folder, subfolder, or file is selected (its name in the left pane is 

highlited), otherwise you might get error messages down the road. To build the project  click on hummer  icon (if 

you click on the triangle right to the hummer icon you will see a menu that also can be used to buid the project).  

You will see the build progress status at the bottom of the main Eclipse window. 
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Wait until the build is completed. 

 

Inside HelloTest  project, expand Binaries to see the just created executable file HelloTes t.exe . 

You also are supposed to see Console view in the lower panel, with build output inside it.  

If Console view is not opened, click on Console tab to open it. If Console tab is missing, go to Window menu, select 

Show View submenu, and select Console option.  
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Running C++ Program  as Local Application  

 

 

Right click on the project folder to open a context menu. Select Run As submenu, select Local C/C++ Application option. 
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The Eclipse will build (again) and run the program. You may see build console output stating that 

there is nothing to be done. 

 

After the build is completed, the program will run.  

 

 

The Console view is supposed to switch to the program output. In the screenshot, you can see the program exit code 

zero  and the program output !!!Hello Word!!! . 
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Switching Console View  

 

If you want to see the build console output, click on black triangle  icon  and select CDT Global Build Console  

from the drop-down menu. Similarly, you can switch to the program output in the console view. 
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Editing Program Code  

 

In the left pane, select HelloTest.cpp file . Click inside the editor pane in the middle and start editing  the source 

code. 

Note asterisk sign *   left to HelloTest.cpp  file name in the editor view. The asterisk means that the file has been 

modified.  

Click on floppy  icon  to save the file. Click on hummer  icon  to rebuild the project.  To run the program, 

ǳǎƛƴƎ ǘƘŜ ƭŀǎǘ Ǌǳƴ ŎƻƴŦƛƎǳǊŀǘƛƻƴΣ ŎƭƛŎƪ ƻƴ άǿƘƛǘŜ ǘǊƛŀƴƎƭŜ ƛƴǎƛŘŜ ƎǊŜŜƴ Řƛǎƪέ  icon . 
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Specifyin g Runtime Parameters  

If you want to specify program runtime parameters, for example, program arguments or environment variables, see 

Appendix 5 ς Program Run Configuration. Note that the default run configuration is created automatically the first time 

the program is run. 

 

 

 

ThatΩs it! You have Eclipse C/C++ Development Tooling and Cygwin working! 
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!ÐÐÅÎÄÉØ ρ ɀ -ÏÄÉÆÙÉÎÇ 7ÉÎÄÏ×Ó %ÎÖÉÒÏÎÍÅÎÔ 6ÁÒÉÁÂÌÅÓ 

PATH Environment Variable  

Access Environment Variables window, for example, by going to Windows Search -Ҕ άŜƴǾƛǊƻƴƳŜƴǘέ -> Edit the system 

environment variables -> System Properties -> Advanced -> Environment Variables. 

In the Environment Variables window, find existing system (or user) PATH variable or create new user PATH variable. 

Add the OpenJDK and Cygwin bin  subfolders to the path variable, as needed. 

Note - The user path is appended to the system path. In most cases, you a folder shall be added either to the system or 

to the user path.  

Including OpenJDK in Windows PATH  

After the OpenJDK files are extracted to an installation folder, consider adding its bin  subfolder to Windows system or 

user PATH variable. Add OpenJDK to the system path if you want all users to be able to use it. Add it to the user path 

otherwise. 

For example, add C: \ Program Files \ OpenJDK\ jdk - 11\ bin  to the system PATH variable. 

Including Cygwin in Win dows PATH 

After the Cygwin packages are installed, it is necessary to add Cygwin bin  subfolder to Windows system or user PATH 

variable. Add Cygwin to the system path if you want all users to be able to use it. Add it to the user path otherwise. 

For example, add C: \ cygwin64 \ bin  to the system PATH variable. 
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Environment Variables in Windows 10  

Accessing Windows 10 System Properties  

Find Windows search box. In the case of Windows 10, it is usually at the left bottom corner of the screen 

 

Start typing word environment  in the search box. 

 

 

Type word environment  in the search box . Click on Edit the system environment variables  if you are 

modifying the variables for all users. Otherwise, click on Edit environment variables for your account . 

If you clicked the Edit the system environment variables, you will see System Properties window. 
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Accessing Windows 10 Environment Variables  

In the System Properties window 

 

press Environment Variables button. 
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Editing Windows 10 Environment Variables  

In this example, we modify PATH environment variable. In the Environment Variables window 

 

If you are adding a folder to the system PATH variable, scroll down in System variables section until you see Path line. 

Click on Path line  to select it. Press Edit  button  in System variables section. 

If you are adding the folder to the user PATH variable that already exists, find it in User variables section, click on it to 

select it, and press Edit button in the User variables section.  



Installing Eclipse IDE on Windows for Java and C/C++ Developers  

© Copyright 2019 Alexander Murashkin            

Page 133 of 292 

Revision 20190205 

You will see Edit environment variable window. 

 

Press New button to add new folder to the bottom of the folder list. 
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Enter the folder pathname in the text box, for example 

C: \ Program Files \ OpenJDK\ jdk - 11.0.1 \ bin  or 

C: \ cygwin64 \ bin  

Press Enter key to complete the pathname. 
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Confirm that the desired folder is in the list . Press OK button to close Edit environment variable window. 
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Saving New Value of Windows 10 Environment Variable  

In the Environment Variables window 

 

press OK button to save the new variable(s) value. If you press Cancel button, the new value(s) will be discarded. 
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If you have System Properties window open, you can close it by pressing OK button. 

Environment Variables in Legacy Windows  

Accessing System Propert ies in Legacy Windows  

Getting to System Properties via Windows Search 

Depending on your Windows version find or open Windows search box. 

Type word environment in the search box . Click on Edit the system environment variables  if you are modifying 

the variables for all users. Otherwise, click on Edit environment variables for your account . 

If you clicked the Edit the system environment variables, you will see System Properties window. Otherwise, you will 

see Environment Variables window. 
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Getting to Environment Variables via Computer Properties 

Right click on your desktop Computer icon to open a context menu and select Properties. If you do not have Computer 

icon open Windows Start Menu 

 

Move mouse over Computer item and right click it to open a context menu.  




















































































































































































































































































































